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1.1. ABOUT THE SOFTWARE 

ArCADia-REINFORCED CONCRETE SLAB software is meant for construction designers. The aim of the 

application is to provide maximum assistance to the user in preparing implementation construction 

drawings for reinforced concrete slabs in CAD software. ArCADia-REINFORCED CONCRETE SLAB 

software is an object-oriented program which uses flat data entered by the user in the form of top and 

bottom reinforcement views and element cross-sections to create a three-dimensional model of slab 

reinforcement that may be edited further and allows, for example, for creating new cross-sections of 

the slab automatically. It is possible to shape slab reinforcement in the software on the basis of 

guidelines from the PN-EN 1992-1-1 Eurocode 2: September 2008 standard. The software allows for 

the designer to enter data on slab shape and support as well as imports the data on slab shape and 

support directly from the ArCADia-ARCHITECTURE software, based on the ceiling determined there. If 

the covering of a given level in ArCADia-ARCHITECTURE consists of several ceilings, all of the ceilings, 

when selected, are exported to ArCADia-REINFORCED CONCRETE SLAB software as separate and 

unrelated models of reinforced concrete slabs. 

1.2. BASIC FEATURES AND FUNCTIONALITIES OF THE SOFTWARE 

ArCADia-REINFORCED CONCRETE SLAB software includes the following features and functionalities: 

 Designing multiple slabs in one document. 

 Importing the ceilings with conditions for their support from the building model in ArCADia-

ARCHITECTURE software. 

 Constructing the geometry and reinforcement of the slab in two main views defined for top 

and bottom reinforcement separately, and any number of assumed slab cross-sections. 

 Full control of the visibility in the drawing and printout for the views and cross-sections 

together with their components and possibility to switch between them while working on a 

model. 

 Possibility to move and add new cross-sections freely and set the visibility depth for 

reinforcement in a cross-section. 

 Possibility to freely shape the contour of the slab and its support in the form of: walls, columns 

and binders and put openings of any shape into the designed slab. 

 Automatic assignment of rectangular reinforcing meshes for any shape of the entire area or 

fragment of the slab, keeping the uniform or alternating reinforcement of the mesh in both 

directions, as well as vertical (top and bottom) and side cover for all the bars in the mesh. 

 Automatic assignment of rectangular reinforcing meshes for user-defined area inside a slab of 

rectangular or arbitrary shape. 

 Possibility to copy defined meshes within top and bottom reinforcement and between those 

layers. 

 Possibility to bend bars from the top mesh towards the bottom one. 

 Possibility to insert and copy regular concentrations of reinforcement in both directions on a 

selected area of a given mesh. 
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 Possibility to introduce an opening of arbitrary shape into a determined mesh, regardless of 

the opening in the slab. 

 Possibility to modify the contour of a mesh and direction of main and secondary bars in a mesh 

and possibility to break a mesh into single customized bars (when the mesh is broken, the 

possible concentration in the mesh is broken as well). 

 Possibility to add single bars in a mesh in main and secondary direction (they are mesh bars 

until the mesh is remodeled).  

 Possibility to copy mesh bars (those that are customized bars, not removed after mesh 

modifications).  

 Possibility to modify the length of single mesh bars (until the mesh is remodeled). 

 Possibility to move the entire layout of bars within a mesh, maintained after the mesh is 

remodeled (without mesh removal). 

 Automatic removal from a mesh of excessive bars which are placed entirely in the area of slab 

supports (walls and binders) during arrangement. 

 Possibility to put vertical punching molders in areas where the slab is directly supported by 

columns. 

 Regular layout of supporting high chairs of top mesh automatically included in the reinforcing 

steel list. 

 Dimensioning the reinforcement in millimeters or centimeters with the possibility to set 

precision. 

 Automatic inclusion of necessary rebar bend radiuses. 

 Possibility to create rebars of arbitrary shape. 

 Possibility to modify diameters and properties of rebars. 

 Automatic display of rebars together with their dimensioning and description (rebar details). 

 Possibility to insert aggregated numeration of slab rebars and their descriptions for rebars with 

regular length increase, which limits the amount of rebar numbers in the slab. 

 Possibility to freely insert descriptions in views and cross-sections of elements. 

 Automatic continuous numeration of all bars within one document or one slab. 

 Possibility to freely shape slab geometry dimensioning. 

 Automatic creation and modification of reinforcement steel list on the basis of created 

reinforcement model (list for a single slab or list for the entire drawing). 

 3D preview of the created slab reinforcement model. 

1.3. GENERAL CHARACTERISTICS OF THE SOFTWARE 

ArCADia-REINFORCED CONCRETE SLAB software is part of a general object-oriented system which aids 

construction designers and is also the second construction module. It is used to prepare detailed 

implementation documentation for RC reinforcing plates. It can work in two basic modes: 

 As a separate application for the user to model ceiling slabs together with their support 

conditions, and for preparing comprehensive implementation documentation for RC 

reinforcing plates. 
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 As an application which cooperates with the ArCADia-ARCHITECTURE module, where the slab 

model is imported from the architectural project and may be further modified, and 

reinforcement implementation drawings may be prepared. 

By inserting slab components (contour and openings in the slab, support in the form of: walls, columns 

and binders, then appropriate top and bottom reinforcement of the ceiling) in the software, a three-

dimensional model of the reinforced concrete slab is created, which can be previewed in 3D at any 

time. The model is created on the basis of data inserted by the user in the form of flat views of top and 

bottom reinforcement and characteristic cross-sections of the slab. By default, the software uses two 

views of top and bottom reinforcement of the slab, and the entire reinforcement is usually modeled 

on their basis, while cross-sections are included in the drawing mainly for informative and illustrative 

purposes. At any moment, the user may remove any view (cross-section) or insert a new one in a 

selected location. Elements of a model (shape of slab, openings in slab, supports, top and bottom 

reinforcement and their descriptions) may be inserted in only one defined active view or cross-section 

(in other, they are automatically mapped according to their location in the model, with the exception 

of descriptions and dimensioning). At any moment, the user may switch the active view or cross-

section using the relevant function from the toolbar. In addition to the elements of a model, other 

elements appear in the project which are not directly related to views and cross-sections. These are 

detailed views of bars (called “displayed” bars), a reinforcing steel list and a title block. Project 

elements available in the software may be divided into three main groups: 

 The elements of the model whose location is mapped in every view and cross-section, such as 

slab geometry with openings and supports in the form of walls, columns and binders, top and 

bottom reinforcement and punching reinforcement bars (spacing high chairs of top meshes 

are only included in the steel list and they are not located in the slab model with precision). 

 Additional elements of the view which do not exist in the actual model and whose location is 

not mapped, attributed to the particular view or cross-section, such as: bar descriptions and 

geometric dimensions. 

 Additional elements which do not exist in the model and are not attributed to any view or 

cross-section, such as: described bar details, a reinforcing steel list or a title block. 

Within one document, the user may insert several types of different slabs, which will be treated by the 

software as separate elements. Dimensioning of reinforcement inserted in a model may be displayed 

in millimeters and centimeters depending on the user’s preferences. Rebar numeration is provided 

automatically by the software (for a single slab or for the entire drawing) and generally the user has 

no influence on that. It is always consecutive and it always applies to all rebars inserted in the model 

of a given slab or the entire document, depending on choices marked in the construction Options of 

the software. 

1.4. REQUIREMENTS AND LIMITATIONS OF THE SOFTWARE 

ArCADia-REINFORCED CONCRETE SLAB software is not an independent application and requires an 

installed CAD program (ArCADia-INTELLICAD, ArCADia-START or AutoCAD) to function properly. 

When using the construction mode in the ArCADia-REINFORCED CONCRETE SLAB module, due to 
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working at the level of construction implementation drawings, the user does not have access to the 

functions of other modules (e.g., Architecture) that are available when working with a level or a 

building. And the other way around – when working with a level, the user does not have access to the 

functions for creating detailed implementation drawings of a construction. Thus, to return from 

construction mode to working, for example, with a level in Architecture, it is always necessary to create 

a new project (document). The functions which are common to the entire ArCADia system are an 

exception here. These include: Project Manager, 3D View, Options, etc., which are available in both 

modes, although their functionality may be slightly different depending on the specificity of a given 

module. 
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2. INSTALLING AND LAUNCHING THE SOFTWARE 
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2.1. HARDWARE REQUIREMENTS 

 Pentium 4 class computer (Pentium Core2Duo recommended), 

 2 GB RAM (min. 4 GB recommended), 

 approximately 1 GB of free HDD space for the installation, 

 DirectX 9.0 compatible graphics card, 

 system: Windows Vista 32/64-bit, Windows 7 32/64-bit, or Windows 8 32/64-bit, 

 DVD-ROM drive. 

2.2. INSTALLATION 

Program installation usually starts automatically when the CD is inserted in the drive. The installation 

should be started manually if the Autostart function is disabled. Open the CD content (Computer/CD 

drive) and run the Setup.exe file from the program folder. Once the installation has started, follow the 

instructions displayed on the screen. 

2.3. LAUNCHING 

The software may be launched by double-clicking the CAD program icon usually located at the Desktop 

and then selecting one of the icons in the ArCADia-REINFORCED CONCRETE SLAB toolbar or the home 

ribbon. 

2.4. OPENING A PROJECT (CAD) 

Any of the following file types may be opened:  

 a standard .dwg drawing file, 

 sample drawings supplied with ArCADia-INTELLICAD, 

 a .dxf drawing exchange file, 

 a .dwf network transmission file, 

 a .dwt drawing template file.  

In order to quickly access the last edited drawing choose File> <file name>. The software stores the 

names of the last four drawings. In order to quickly access a drawing from the Open drawing dialog 

box, double-click its name. 

A drawing may be opened when browsing drawings on the computer, for example using the Windows 

Explorer. All you need to do to open a drawing in ArCADia-INTELLICAD is to double-click the file. 

Thumbnails displayed when browsing help identify the drawing you need. 

Opening an existing drawing 

Use one of the following methods: 
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 Choose File>Open. 

 On the Standard toolbar, select the Open tool. 

 Write Open and then press Enter.  

 Choose the type of the file you want to open from the file types.  

 Choose the folder that contains the selected drawing.  

 Do one of the following:  

 Choose the drawing that you want to open and click Open.  

 Double-click the drawing you want to open.  

If the drawing requires a password, provide the password, then click OK to verify the password and 

then click Open again. 

2.5. SAVING A PROJECT (CAD) 

A drawing may be saved at any moment. 

In order to save a drawing use one of the following methods: 

 On the Standard toolbar, click Save. 

 Choose File>Save. 

 Write save and then press Enter. 

 Write qsave and then press Enter. 

When you save a particular drawing for the first time, the system will display a dialogue box Save 

drawing as, which allows you to select the folder and provide the name for the drawing. You may use 

any name when saving the drawing for the first time. In order to save the same drawing under a 

different name later, select File>Save as and then type in the new name. 

2.6. AUTOSAVE AND BACK-UP COPY (CAD) 

In order to avoid data loss in case of a power outage or a system error, save your drawing files often. 

The software may be configured so that it saves your drawings automatically from time to time. The 

Autosave setting determines the interval between automatic saves in minutes. The software resets 

that interval each time the user saves a drawing file. 

When the Autosave feature is activated, the software creates a copy of the drawing. That file is 

automatically saved in the folder specified under Options>Paths/Files>Temporary file and given the 

extension indicated in the Drawing autosave file extension (SV$ by default). 

Configuring the ArCADia-INTELLICAD to automatically save drawings 

1. Do one of the following: 

 Select Tools>Options. 

 Write config and then press Enter. 
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2. Click the General tab. 

3. In the Autosave area, select the check box in order to turn the Autosave feature on and select 

autosave frequency. 

4. Click OK. 
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3. WORKING WITH THE SOFTWARE 
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3.1. THE ARCADIA-REINFORCED CONCRETE SLAB TOOLBAR AND HOME RIBBON 

 

 

Rys. 1 The ArCADia-REINFORCED CONCRETE SLAB main toolbar in  
AutoCAD and ArCADia-INTELLICAD software 

The layout of the software main toolbar in CAD applications (AutoCAD, ArCADia-INTELLICAD) is 

presented above. It includes the following range of functions: 

 

Rys. 2 ArCADia-START application main tool ribbon with  
ArCADia–REINFORCED CONCRETE SLAB software 

Presented above is the layout of the ArCADia-START application main tool ribbon with ArCADia–

REINFORCED CONCRETE SLAB software. It includes the following range of functions:  

 

*BIM – options available to ArCADia BIM license holders, i.e. after purchasing one of the following 

programs: ArCADia, ArCADia AC, ArCADia LT or ArCADia PLUS. 

 

Icon Option Description *BIM 

 
Slab Inserts a slab contour of customized shape. X 

 
Rectangular slab  Inserts a rectangular slab contour. X 
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Slab from XML  Inserts slab geometry from ArCADia-ARCHITECTURE 

software XML file. 
X 

 Wall Inserts a slab support in the form of a wall. X 

 Binding joist Inserts a slab support in the form of a binder. X 

 
Column Inserts a slab support in the form of a column. X 

 
Roof opening Inserts an opening into the slab. X 

 
Rebar Inserts a customized bar into the slab. X 

 
Net Inserts a reinforcing mesh of customized shape. X 

 
Mesh automatically Inserts a reinforcing mesh on the entire area of the slab. X 

 
Mesh opening Inserts an opening into the reinforcing mesh. X 

 
Mesh ratio Inserts a concentration into the reinforcing mesh. X 

 
Rebar details Inserts details for a single bar. X 

 
All rebar details Inserts all the details of the bars. X 

 
Space rebar details Inserts the details of a spacer bar (high chair). X 

 
Rebars description Inserts a description of the bars. X 

 
Aggregated rebars 
description 

Inserts a description of the aggregated bars. X 

 
Dimension Inserts any dimension. X 

 
Steel list Inserts a project steel list. X 

 
Item steel list Inserts a steel list for a single slab. X 

 
Cross-section Inserts a cross-section of the slab. X 

 
Bottom view Inserts a bottom reinforcement view of the slab. X 

 
Top view Inserts a top reinforcement view of the slab. X 

 
Activate Activates the indicated construction view. X 

 Help Displays the help window. X 
 

3.2. SETTINGS AND MODULE OPTIONS OF ARCADIA-CONSTRUCTIONS 

ArCADia-CONSTRUCTIONS Module Options window includes the general program settings. 
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Rys. 3 ArCADia-CONSTRUCTIONS Module Options window 

The Options window includes basic settings for reinforcement presentation in a document. These are 

the following parameters respectively: 

Reinforcement bend radius – determining for what kind of reinforcement the bend radius should be 

visible: 

 Occurs nowhere. 

 Occurs everywhere. 

 Occurs only for reinforcement with diameter equal or greater than… 

Dimension of bend radius – determines the rebar bend radius value: 

 Standard (2 x for reinforcement diameter ≤ 16 mm and 3.5 x  for reinforcement diameter 

> 16 mm). 

 Amplified – according to the standard PN-EN 1992-1-1 formula (8.1). 

Hooks in reinforcement – due to using only ribbed steel in the software, hook shape actually applies 

only to stirrups (for the other bars, the possible hooks have to be inserted individually): 

 At angle 90. 

 At angle 30. 
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Length unit in rebar details, descriptions and dimensions – a parameter which enables the user to 

choose dimensioning unit for reinforcement or an element with possible rounding to 5 mm (for bars 

details and descriptions): 

 Millimeters (possible rounding to 5 mm).  

 Centimeters (possible rounding to 5 mm). 

Arc length in rebar details – a parameter which enables to set for which reinforcement type the arc 

length should be visible using the bend radiuses: 

 Visible for rebars (longitudinal). 

 Visible for stirrups. 

Rebar numeration: 

 Common numeration for all bars in the document – consecutive numeration of all bars in the 

entire document, reinforcing steel list for the entire document or for a single structural 

element. 

 Separate numeration for each structural element – consecutive numeration of all bars in the 

element, starting from number 1 for each element and thus giving the same numbers to 

different bars in the document. Reinforcing steel list only for a single structural element. 

By default, a slab model inserted into the drawing, regardless of dimensioning unit settings in Options 

described above, will be drawn with actual-size scale where one unit in the drawing corresponds to 

one centimeter in reality. At any moment, while working on the project, the user may change the unit 

in the drawing (e.g., to millimeters) by opening the Properties window for a selected View anchor – 

Projection 1. 

 

Rys. 4 The element Properties window for a View anchor 
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Changing units in the drawing (e.g., from centimeters to millimeters) rebuilds the scale of entire 

drawing (model, descriptions, dimensioning, etc.) but does not change the dimensioning way or 

dimension lines and bar details. 

All options and setting described above always regard all elements of the project included in the 

drawing. 

3.3. PROJECT MANAGER AND 3D VIEW 

In the Project Manager of ArCADia–REINFORCED CONCRETE SLAB module, at the projection after 

inserting a slab into the document, by default there are two available views visible (bottom 

reinforcement view and top reinforcement view) and possibly inserted cross-sections of the slab. 

Double-clicking on any of them makes the given view active. Active view is displayed in bold in Project 

Manager. In the project tree presented in the Manager, you can remove particular elements or their 

views (in the context menu under the right mouse button). You can freely set the visibility for the 

elements of the model included in particular views, lock them on the screen or turn them off on the 

printout.  

 

Rys. 5 Project Manager window 

Choosing 3D View tab in the Project Manager activates a preview window for a 3D model of the slab 

with reinforcement inserted. Then, in the Project Manager window you can set the visibility, 

transparency, etc., for particular elements of the project. If there are several different slabs designed 

within one document, only one of them will be visible in the 3D View – the one which is currently 
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active in the 3D View tab of the Project Manager. To change the active slab in the 3D View tab of the 

Project Manager, you need to click on the appropriate slab icon. 

 

Rys. 6 3D View window for a slab 

3.4. WORKING WITH THE VIEWS AND INSERTING A CROSS-SECTION 

Upon inserting into a project, a new slab is presented in two basic views (bottom reinforcement view 

and top reinforcement view) and it is on them that you can insert the basic reinforcement of the slab. 

For reinforcing plates which are reinforced only on the bottom (e.g., single-span slab) or only on the 

top (e.g., balcony cantilever slab), excessive and unnecessary reinforcement view may be removed 

from the project. After you place support and construct basic top and bottom reinforcement of the 

slab, you should place illustrative cross-sections in its characteristic locations using the  – Insert 

cross-section option. You can insert several different cross-sections of the slab into the drawing within 

a project, usually made in different directions. In order to keep them correct, you should follow the 

rule that their direction should always be parallel to the main or secondary direction of the slab 

reinforcement. After inserting the views and cross-sections into the drawing, one of them (the one 

with the darker color of the frame) is always active, this means that you can make changes to the slab 

model in it and insert elements assigned to the view or cross sections into it (e.g., dimensions or 

descriptions). To change the active view (cross-section) into a different one, double-click on the 

appropriate view or cross-section name in the tree of the Project Manager or use the  – Activate 

the indicated construction view function from the main toolbar. After using the function from the 

toolbar, indicate with the mouse cursor which view you want to activate by clicking anywhere within 

the frame of the given view. After you select the frame of the inserted, active view or cross-section, 

four anchors which allow for resizing the area of a given view and one anchor (in the bottom left corner 
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of the frame) for moving the entire view around the drawing will be displayed. All elements of the 

model and those assigned to the view (dimensions and descriptions) are moved together with the 

view. The frames of different views and cross-sections may overlap each other within one drawing. In 

this case, it is important that the elements inside the frames do not overlap (presented model, 

descriptions, dimensions, etc.). Under the bottom left corner of the view frame, you can see the name 

of the particular view, the name of the element included in the view, and the number of elements by 

the same name can be found in the reinforcing steel list for particular elements. This description and 

the frame are set not to be visible on the printout. To insert titles for particular views or other 

descriptions, such as scale or the number of items, which will be visible on the printout, you need to 

use the standard text insertion from CAD software. When inserting a cross-section or selecting the 

frame of already inserted cross-section, from the insertion or action bar, you can enter the cross-

section Properties window and set a graphical presentation and designation for the cross-section. In 

the cross-section Properties window, you can also set the Bar visibility depth, i.e., the depth to which 

the bars in the cross-section will be visible. This option is set to 40 cm by default and changing it allows 

for controlling which bars will be visible in the cross-section. The following will always be visible in the 

cross-section inserted into a drawing: intersected slab cross-section contours, intersected rebars lying 

vertically to the cross-section plane and rebars parallel to the slab plane which are within the Bar 

visibility depth. 

 

Rys. 7 Element Properties window for a cross-section 

3.5. BUILDING A SLAB MODEL 

A model of the designed slab consists of the following basic elements: 

 external contour of the slab, 

 contours of the slab internal openings, 

 linear supports in the form of structural layer of walls or binders, 

 local support in the form of columns. 

There are two possible methods to create such model in ArCADia–REINFORCED CONCRETE SLAB 

software: 
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 automatic or manual importing of a given ceiling model with openings and support from the 

ArCADia-ARCHITECTURE software building project, 

 individually creating the model of a slab using the tools available in ArCADia–REINFORCED 

CONCRETE SLAB software. 

3.5.1. Importing a ceiling model from ArCADia-ARCHITECTUREsoftware 

The easiest method for obtaining the model of a slab is to import the appropriate ceiling from ArCADia-

ARCHITECTURE software. There are two ways to do this: 

 Open the building project in ArCADia system, select the appropriate ceiling(s) from the model 

or from the Project Manager and choose the Export to ArCADia–REINFORCED CONCRETE 

SLAB function from the action bar for the ceiling. Then a new DWG drawing will open in the 

construction mode and after you select the template, consecutive slab models will be inserted 

into it in the locations you indicate. This way, a full model of the slab together with openings 

and support is imported (only internal support layer is imported for layered outside walls). 

Such model may require some minor corrections using the tools available in the ArCADia–

REINFORCED CONCRETE SLAB software, depending on the quality with which it was made in 

the architectural program. 

 

Rys. 8 Exporting a ceiling into ArCADia–REINFORCED CONCRETE SLAB software 

 The second method is different from the first, because here XML file is used to import the 

selected model. Choose the Export to ArCADia–REINFORCED CONCRETE SLAB through XML 

file option from the action bar and save the ceiling model into XML file on your hard drive, 

using any name you want. Next, open a new DWG drawing and from the main toolbar of 

ArCADia–REINFORCED CONCRETE SLAB software start the  – Insert a complete slab from 

XML file function. After indicating the previously saved file, load the consecutive models of the 

slab the same way as in the previous method. 

 

Rys. 9 Exporting a ceiling into ArCADia–REINFORCED CONCRETE SLAB software through XML 
file 
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3.5.2. Building a slab model 

3.5.2.1. Inserting a slab area into the project 

Creating a slab model individually should always be started with inserting its area limited by the 

determined contour (other functions of ArCADia–REINFORCED CONCRETE SLAB module will be 

unavailable until the slab area contour is inserted). There are two functions for doing this in the 

software:  – Insert a slab and  – Insert a slab using a rectangle. The first of these functions 

allows for inserting an RC slab contour of customized contour shape. After selecting it, you can choose 

the slab Properties option from the action bar for the inserted slab. 

 

Rys. 10 The Properties window for the inserted slab 

In the Properties window, you can define the basic parameters of the inserted slab, like: the name of 

the slab, quantity of slabs, top, bottom and side reinforcement cover, thickness of the slab and the 

designed concrete class. In this window, you can also show and hide the marker of the slab used for 

its quick selection, which will not be visible in the drawing printout after unchecking the box. If the slab 

Properties window is opened,  after inserting the top meshes, the option to define the Properties of a 

spacer bar will be available, where you can set its diameter and placement in the form of defined 

number of spacer bars (high chairs) per 1 m2 of top mesh. 
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Rys. 11 Spacer bar (high chair) Properties window 

After defining the parameters of the slab in the Properties window, indicate the consecutive points of 

the slab contour in the drawing, using precise insertion with CAD program tools. After the last point of 

the contour is inserted, finish by pressing ESC or clicking the right mouse button. When inserting a slab 

contour, you should remember that the contour lines cannot cross. After you finish inserting the slab 

contour, indicate the location of both default views (for top and bottom reinforcement) in the drawing. 

Similarly, when inserting the slab using a rectangle, indicate the first and the last point of a given edge 

of the slab rectangle and next the dimension of the slab in the direction parallel to this edge. After 

defining both dimensions, indicate the locations of both default views of the slab in the drawing (for 

top and bottom reinforcement).  

After inserting both views of the slab and selecting the slab, you can change in the displayed action bar 

the previously set Properties and the contour of the slab by adding or removing contour bend points 

or by changing the location of the basic points of the displayed slab contour using CAD program tools. 

 

Rys. 12 Action bar for the selected slab 
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3.5.2.2. Inserting openings and supporting elements into a slab 

To insert openings into a slab, use the  – Insert opening into slab function. Next, insert consecutive 

points for the opening contour using precise insertion with CAD program tools. After the last point of 

the contour is inserted, finish by pressing ESC or clicking the right mouse button. When inserting an 

opening contour, you should remember that it must be placed entirely inside the slab contour and that 

the inserted contour lines cannot cross. When inserting an opening into a slab in which reinforcing 

meshes have already been placed, reinforcement from the mesh will automatically be cut out in the 

area of the opening, keeping the side cover of the bars from the edge of the opening. 

After inserting an opening into a slab, you can proceed to forming the support conditions under the 

slab. There are three separate functions for this purpose in the software:  – Insert wall,  – Insert 

column,  – Insert binder. All elements described above, as well as openings in the slab, may be 

inserted in only one of the views of the top or the bottom reinforcement and they will be automatically 

copied to the other one. 

After choosing the  – Insert a wall option, you can select from the displayed action bar the edge or 

axis with which you want to insert the wall into the active view of the slab. Selecting the edge is 

important if the outer edge of the wall coincides with the edges of the previously inserted slab area. 

 

Rys. 13 Action bar for the inserted wall 

In the action bar, you can open the Properties window for the inserted wall, where you can set: wall 

height which will be visible in the slab cross-sections, marker for the end of the wall with a break line, 

wall thickness and hachures for walls cut in the slab cross-section. Turning off the hachures will in 

effect cause the wall element to be perceived as reinforced monolithic and it will be directly connected 

with the area of the slab in the cross-section (no line separating the wall from the slab view in the 

cross-section). 
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Rys. 14 Properties window for a wall 

After setting the wall properties, you can proceed with inserting it in any view of the slab. To do this, 

indicate the consecutive points for the location of the wall edge or the wall axis in the drawing, using 

the snapping points and other tools for precise insertion. After the last point of the wall is inserted, 

finish by pressing ESC or clicking the right mouse button. Besides the access to the Properties window, 

the action bar for the already inserted wall provides two functions: Wall lengthening (shortening) and 

Wall dividing. 

 

Rys. 15 Action bar for a wall 

Inserting a binder into a slab is similar to inserting a wall. After evoking the appropriate function from 

the action bar for binder, choose the Binder properties window. 

 

Rys. 16 The action bar for inserted binder 
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Rys. 17 Binder Properties window 

In the binder Properties window, set its width and height. When the automatic mode is on, the height 

is understood as the reminder between the top surface of the slab and the bottom of the binder. When 

the automatic mode is off, you can additionally define the binder height under the slab, which allows 

for inserting, into the model, binders which protrude out of the slab downwards and upwards or have 

their bottom flush with the underside of the slab. Similarly as is the case of walls, besides the access 

to the Properties window, the action bar for the already inserted binder provides two functions: Binder 

lengthening (shortening) and Binder dividing. 

Another supporting element which can be inserted into the project is a column. The  – Insert 

column function can be evoked from the main toolbar and after the action bar for the column is 

displayed, you can select its Properties and the insertion point on the edge of the column cross-section. 

 

Rys. 18 The action bar for the inserted column 
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Rys. 19 Properties window for a column 

In the Properties window of a column, you can set the shape of its cross-section (rectangular or round), 

section dimensions (width and height for a rectangular cross-section and diameter for a round one), 

column height visible in the slab cross-section, manner in which it ends with a break line and the angle 

of rotation of the inserted column in the top or bottom reinforcement projection. In this window, you 

can also set the manner of hatching the column in the slab cross-section which goes through the 

column. Turning off the hachures will in effect cause the column to be perceived as reinforced 

monolithic and it will be directly connected with the area of the slab in the cross-section (no line 

separating the column from the slab view in the cross-section). 

After setting the inserted column parameters in its Properties window, you can proceed to inserting 

its location in the top or bottom reinforcement view. The function for inserting columns into the slab 

model works repeatedly until it is terminated by pressing ESC or clicking the right mouse button. 

 

3.5.3. Copying a slab between documents or within one document 

The software allows for copying the finished slabs between different documents or within one 

document. This function allows for the creation of a new project on the basis of the elements (slabs) 

copied from different previously made projects and inserting appropriate modifications into them. 

When copying a slab, its full model with reinforcement inserted may be copied. The software copies 

the entire slab using the standard method of copying through the clipboard: In the active view, 

highlight with a window the slab you want to copy, press CTRL+C, go to the new document or stay in 

the same, press CTRL+V and indicate the location of the copied slab in the drawing. To copy the entire 
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slab within one drawing or between documents, at least one contour of the designed slab must be 

highlighted in the active top or bottom reinforcement view before copying to clipboard. Additional 

highlighting of the remaining elements has no influence on the way of copying the slab. When the slab 

is copied to clipboard, the remaining supporting elements, such as walls, columns, binders, openings 

in the slab, top and bottom reinforcement, linear dimensions, bar descriptions and all views and cross-

sections of the slab, are copied as well. When coping through the clipboard, the drawing elements 

which do not belong to the particular view or cross-section, i.e., reinforcing steel lists and rebar details, 

are not copied. Supporting elements of the slab, reinforcement and its descriptions and dimensions 

cannot be copied through the clipboard. 

When using the standard copy option available in CAD programs, you can only copy within a single 

document. In this case, to copy the entire slab together with all its supports, views and cross-sections, 

at least one contour of the designed slab must be highlighted in the active top or bottom reinforcement 

view before evoking the copy function. Upon selecting a view frame or a cross-section frame, the copy 

function will allow for inserting another identical view or cross-section within the same structural 

element (slab). 

3.6. INSERTING THE REINFORCEMENT 

3.6.1. General characteristics of formed slab reinforcement 

The rules for the formation of reinforcement in the software refer to the guidelines from the standard 

PN-EN 1992-1-1 Eurocode 2: September 2008. When forming the reinforcement, the software 

automatically inserts rebar bend radiuses (if the option for including the bend radiuses is selected in 

the software Options). 

In the calculation of bend radiuses, the rule included in the table 8.1N or the formula from PN-EN 1992-

1-1 Eurocode2 standard are used, depending on the settings selected by user in the software Options. 

Because the Eurocode refers only to ribbed steel reinforcement with a yield stress from 400 to 

600 MPa, automatic hook addition has not been used for slab bars. 

Possible anchoring and overlap lengths for longitudinal bars in a mesh of a slab should be predicted 

individually by the user during reinforcement formation, by using the appropriate formulas 8.4, 8.10 

and 8.11 of the PN-EN 1992-1-1 Eurocode 2 standard. 

The dimensions and geometry of reinforcement punching molders and of spacer bars for the mesh (so 

called high chairs) are adopted automatically depending on the diameter of these bars and the 

thickness of the designed slab set by the user. 

The main reinforcement of the slab consists of reinforcing meshes (top and bottom) and their 

concentrations. The shapes of rebars in meshes and their concentrations are automatically adjusted 

according to the shape of the slab, including the openings in the slab and keeping the defined top, 

bottom and side covers. The automatic placement of the mesh also removes those bars from the mesh 

which are located entirely in the area of support in the form of walls or binders. For top meshes, you 

can choose the option bending the ends of all the bars in the mesh towards the bottom mesh. Every 
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change in the geometry of the slab projection together with its openings will cause the rebuilding of 

reinforcing meshes and the concentrations within them, and removal of the bars added to the mesh. 

Added bars do not automatically adjust to the shape of the slab (the user defines their dimensions) 

and they may protrude outside the contour of the slab or the opening in it. Changing the thickness of 

the slab does not cause the meshes to rebuild but the vertical fragments of the bars in the slab get 

extended (high chairs, punching reinforcement bars and bent bars from the top meshes). 

The sequence for inserting the reinforcement into the slab is generally at user’s discretion, but due to 

the automatic adjustment of meshes and their concentrations to the shape of the slab, which was 

described above, to maximally reduce the necessary workload, the following recommendations should 

be applied: 

 The fundamental principle is to always create a slab model with appropriately located 

openings and support first. 

 Reinforcing the slab should begin with inserting reinforcing meshes, their concentrations and 

the openings in the defined meshes. 

 After properly defining the meshes, you may add, remove and modify the inserted bars of the 

mesh. 

 Next, you may insert the possible individual bars into the model, including the copied bars of 

the mesh. 

 At the very end, you should define the location of the punching molders. 

 After finishing the modelling of the slab reinforcement, you should make its characteristic 

cross-sections. 

 Inserting the descriptions for bars in the top and bottom reinforcement views should begin 

with the insertion, if necessary, of the descriptions for the aggregated bars with constant 

length increase. 

 After inserting all the bar descriptions in the views and cross-sections, the projected bars 

(avatars) and reinforcing steel lists should be inserted into the drawing. 

After inserting the full model of the slab into the drawing, you can supplement the views and cross 

sections with necessary dimensions at any time. If reinforcing meshes together with their 

concentrations have already been inserted into the views and some of the bars in those meshes have 

been modified, each change to the slab model (except for its thickness) will result in the rebuilding of 

the meshes and recreating their initial versions. In this case, if you want to keep the present shape of 

the bars in the mesh, you can break the meshes into individual bars before changing the model, but 

note that then they will not adjust to the modified slab model and they will never be a part of the 

automatically pre-defined mesh. In order to return to automatic mesh after breaking the meshes, you 

must remove the broken bars and reinsert the mesh. 

3.6.2. Inserting reinforcing meshes into a slab 

The software includes two functions for inserting reinforcing meshes: – Insert reinforcing mesh and 

 – Insert reinforcing mesh automatically. The difference between them regards the area where the 

mesh is assigned. In the first case, the area is indicated by the user who has to insert the consecutive 

bend points of the mesh contour, and after inserting the last point, has to finish by pressing ESC or 
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clicking the right mouse button. In the case of the second function, only one arbitrary point inside the 

slab projection contour needs to be indicated and the mesh is inserted into the entire area of the 

indicated slab by default. In both cases, during the insertion of the mesh, the openings in the slab 

located in the area where the mesh is inserted cause the reinforcement to be cut out, keeping the 

rebar side cover from the edges of the opening. Upon evoking one of these functions, the action bar 

for the mesh will be displayed on the screen; you can access the Mesh properties window from the 

action bar by pressing the appropriate button.  

 

Rys. 20 Action bar for inserted reinforcing mesh 

 

Rys. 21 Properties window for reinforcing mesh 

In the software, reinforcing mesh is understood as a layout of orthogonal rebars arranged in the main 

and secondary directions. Main bars are those with reinforcement edge distanced by default in the 

distance equal to the defined cover from the top or bottom surface of the slab. Secondary bars of the 
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mesh are orthogonal to the main bars which are located above or below the main bars from bottom 

or top meshes respectively. For both main and secondary bars, two diameters arranged alternately 

may appear at the most which gives as a result, for example, reinforcement of 12/16 every 20 cm 

in a given direction. In the mesh properties window, the following parameters can be set: 

 Cover distance (default 0 cm) – a parameter which allows to move the surface of the mesh 

(upwards or downwards, depending on the sign) in relation to the default cover (top or 

bottom) set in the slab parameters [cm]. 

Reinforcement in the main direction: 

 Main diameter or Main and additional diameter (optional) of the main bars of the mesh 

[mm]. 

 Spacing of bars in the main direction of the mesh [cm]. 

Reinforcement in the secondary direction (optional): 

 Main diameter or Main and additional diameter (optional) of the secondary bars of the mesh 

[mm]. 

 Spacing of bars in the secondary direction of the mesh [cm]. 

 Yield stress for all rebars in the mesh [MPa]. 

 Bend markers for bending of the top mesh bar ends towards the bottom mesh (the option is 

only available for the top meshes of the slab). 

Resigning from the reinforcement in the secondary direction option allows for inserting meshes with 

unidirectional bar layout (e.g., as an option for an additional mesh, since even slabs with unidirectional 

reinforcement use a transverse reinforcement). 

After defining the parameters of the inserted mesh, indicate the direction of the main bars layout in 

the mesh. 

 

Rys. 22 Bidirectional and unidirectional meshes inserted into a slab 
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In the drawing, the unidirectional meshes are marked with a single hook placed in the direction of the 

mesh and the bidirectional meshes are marked with two crossed hooks, the longer of which always 

points in the main direction of the mesh. During automatic insertion of the mesh bars, the mesh bars 

which are entirely placed within the area of slab support (walls and binders) are always removed, 

because usually they are excessive and unnecessary in the process of slab reinforcing.  

3.6.3. Modifying mesh reinforcement 

Reinforcing meshes inserted into the top or bottom reinforcement view can be modified, after 

selecting, directly by using the functions available in CAD programs such as move, copy or remove. You 

can also modify the location of the contour base points and symbolic marking with hooks for the 

selected mesh. After selecting the mesh inserted into a view, a special set of functions for mesh 

modifications becomes available in the action bar displayed for this mesh.  

 

Rys. 23 Action bar for the selected bottom mesh 

 

Rys. 24 Action bar for the selected top mesh 

Aside from the access to the functions described above, additional functions are available in the mesh 

Properties window: 

 – Add a mesh contour point 

 – Remove a mesh contour point 

 – Re-distribute mesh bars 

 – Insert a mesh concentration 

 – Insert an opening into the mesh 

 – Break the mesh into rebars 

 – Insert mesh bars 

 – Move reinforcement within the mesh 

 – Copy the mesh reinforcement into the other view 
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 – Insert a punching reinforcement bar (only for top meshes) 

The Add (Remove) a mesh contour point functions allow for adding and removing a point in the mesh 

contour and, therefore, they extend the range of possibilities for modifying the area of the mesh 

through relocating its base points. The Redistribute mesh bars function allows for restoring the initial 

layout of the rebars in the mesh, whilst if the Move reinforcement within the mesh function has been 

used for the inserted mesh, this displacement will be included in the new layout of the bars. 

The Insert a concentration into the mesh function allows for regular uni- or bidirectional concentration 

of the inserted mesh in the user indicated area which is a part of the mesh area. After selecting it, you 

can go to concentration Properties window from the displayed action bar and set the parameters of 

the concentration. 

 

Rys. 25 Action bar for the inserted mesh concentration 

 

Rys. 26 Mesh concentration Properties window 

In the mesh concentration Properties window, you can set the direction in which the mesh will be 

concentrated (main, secondary or both), the number of bars for concentration in a given direction and 

bar diameter for concentration. Number of bars for concentration in a given direction means a number 
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of bars which will be evenly distributed in one gap in the reinforcing mesh for which the concentration 

is inserted.  

After determining the parameters of the concentration in the Properties window, proceed to 

indicating the consecutive contour points for the concentration area in the drawing. The inserted 

concentration area may protrude outside the mesh area, or even the slab area, but the concentration 

of bars will be performed only within the area of the given mesh. Bars from concentrations, similarly 

to mesh bars, are removed upon the insertion of the concentration if they are located entirely in the 

areas of support (walls and binders). If bending of the top mesh bar ends towards the bottom mesh 

has been set, the ends of the bars from the concentration within this top mesh will also be bent 

towards the bottom mesh. If a mesh is unidirectional, the concentration in this mesh can only be 

inserted in the same direction as the direction of bar layout in this mesh. The concentration contour 

in a mesh may be modified by moving, adding and removing its base points. You can also move, copy 

and remove concentrations using the general functions of CAD programs. 

 

Rys. 27 Unidirectional concentration (in the main direction) of the bottom mesh 

Another function for modifying a mesh is Inserting openings into a reinforcing mesh. The difference 

between the opening in a slab and the opening in a mesh is that the first one cuts out all top and 
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bottom reinforcing meshes in the opening area and all the cut bars reach the edge of the opening to 

the distance of side cover set in the slab (it is an actual opening). In case of the opening in the 

reinforcing mesh, however, only bars from this particular mesh are cut out and the cut bars directly 

reach the contour of the opening in the mesh. The opening in a mesh is a virtual item which only 

facilitates the modelling of the reinforcement in a slab using meshes. If the opening is inserted into the 

top mesh for which bending of bar ends towards the bottom mesh has been set, the ends of the bars 

cut by the opening will also remain bent towards the bottom mesh. The opening in the mesh cuts the 

bars in the mesh and in its concentrations but does not cut the single bars added to the mesh. The 

contour of the opening in the mesh can be modified by moving, adding and removing its base points. 

You can also move, copy and remove openings using the general functions of CAD programs. Before 

printing the drawing, you should also remember to hide the edges of openings in the meshes in the 

Project Manager so, as a auxiliary objects, they will be invisible.  
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Rys. 28 A unidirectional top mesh with an opening cut in the mesh inside a slab 

The Break a mesh into single rebars function is irreversible (except for the undo the operation 

function) and you should always carefully think through whether it is necessary to use it. It may be 

used if an automatically inserted mesh reinforcement has been modified to a significant degree, i.e., 

the bars in the mesh have been shortened, elongated and removed and you expect to perform an 

operation which may rebuild the mesh bringing it back to the initial state. In this case, in order to keep 

the reinforcement shape from before the operation, you can break the mesh into individual bars, 

keeping in mind that, from this moment, they will not be treated as a mesh but as single bars and that 

the only way to return to the mesh is to remove them and insert a new mesh. Usually, the operation 

of breaking a mesh should be performed only for nearly completed drawings, when for some reason, 

it is necessary to perform an operation which will rebuild the reinforcing meshes. 
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The Insert mesh bar function enables to insert single bars in any location in the mesh, which will always 

be laid only in the main or secondary direction of the mesh and the axis of the horizontal section of 

such bars will be located on the same level as the rest of the main and secondary bars in this mesh. 

These bars may protrude outside overall dimensions of the slab or the edge of an opening in the slab 

and even over the edge of an opening in the mesh. The shape of the bars inserted into a mesh matches 

the rest of the main or secondary bars in the mesh, so for the top meshes with ends of the bars bent 

towards the bottom mesh, the same will apply to the bars inserted into the mesh. All bars inserted 

into a mesh will be automatically removed after rebuilding the mesh, e.g., as a result of changing its 

shape or inserting an opening into it. 

Other automatically distributed mesh bars may be modified by changing the location of their ends 

(e.g., by moving their base points), or moved and removed from the mesh using the general functions 

of CAD programs. However, you should remember that changes of this type will remain only until the 

first operation which causes the rebuilding of the mesh, when its initial version will be recreated. 

Therefore, if the necessity to perform such operation arises it should be performed rather in the final 

stage of creating the slab reinforcement drawing. 

The alternative for the bar modifications described above is to insert a copy of the selected bar using 

the Copy function available in CAD programs. The copy of a bar obtained this way is no longer a mesh 

bar but a customized bar and further modifications of its location and shape will be maintained in the 

project whether the mesh is rebuilt or not. 

During automatic distribution of mesh bars, the user has no influence on the location of the first mesh 

bar in a given direction from which the regular spacing of the rest of the bars in this direction will be 

calculated. In order to change this situation, the Move reinforcement within the mesh function has 

been introduced, which allows for moving usually the first mesh bar (and all the rest together with it) 

into the location indicated by the user. If the user indicates a location for the first mesh bar that it is 

located entirely under a linear support (a wall or a binder), the spacing of mesh bars will be calculated 

according to the user’s indication but the first bar will be removed because of being located entirely in 

the support area. 

The Copy the mesh reinforcement into the other view allows for copying the top reinforcing meshes 

into the exact same location in the top reinforcement view and the other way around, where the 

meshes are always copied as straight, without the possible bar bending for top reinforcement meshes. 

The following are copied together with the mesh: concentrations and openings in the mesh, bars 

added to the mesh and modified mesh bars. Individual bars (even if they have been created as copies 

of mesh bars) and bars belonging to other meshes are not copied. 

In top meshes, you can insert vertical punching molders around columns, using the Insert punching 

reinforcement bar function. The shape of this bar is determined automatically by the software on the 

basis of the slab thickness, the top and bottom cover of the meshes and the defined diameter of the 

molder. The user indicates only the location of punching reinforcement bars in the top reinforcement 

view of the slab (usually in the location of the main and secondary mesh bars intersections). After 

evoking the function in the action bar, as always, the Punching reinforcement bar properties window 
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is available, where you can define the bar diameter and its torsion angle in the top reinforcement view 

of the slab. 

 

 

Rys. 29 Punching reinforcement bar Properties window 

An example of punching reinforcement bars location around a column in the top reinforcement view 

and cross-section of the slab is presented below. 
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Rys. 30 Punching reinforcement bars in the top reinforcement view of the slab 

 

Rys. 31 Punching molders visible in the cross-section of the slab 

3.7. INSERTING A CUSTOMIZED BAR AND MODIFYING REINFORCEMENT 

Single bars of customized shape may be inserted into a slab. For this purpose, the  – Insert a 

customized bar into the slab function is available in the software. After evoking the function, the 

Properties window can be accessed from the action bar. There you can select the bar diameter and 

define its yield stress.  
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Rys. 32 The Properties window for a customized bar in a slab 

After defining the bar parameters in the Properties window, you can proceed to determining its shape 

by indicating the consecutive points of the broken line using the graphical aids in the insertion bar and 

the typical tools of CAD programs, such as: precise relative coordinates, snapping points, etc. A 

customized bar is always inserted in the active view of the top or bottom reinforcement or in the cross-

section and it is copied in the remaining views and cross-sections. When defining a bar of customized 

shape, each of its bends is rounded using a bend radius appropriate for bars of a given diameter, 

according to rules determined in the software Options. If you select several customized bars in the 

model, you can choose from several operations available in the action bar. 

 

Rys. 33 The Action bar view for several customized bars selected 

These are in order from the left: 

  – The function for inserting the details for the selected bars (inserting projected bars). 

  – The function for inserting descriptions of all selected bars in one common reference 

(indicate the view, where the description references are to be inserted and next the location 

of the reference). 

  – The function which adjusts the ends of the inserted bar to the level of the bottom mesh 

cover in the slab. 
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When only one customized bar is selected, the number of operations available for it in the action bar 

significantly grows. 

 

Rys. 34 The Action bar view for a single customized bar selected 

Three very essential options are added then: 

  – The function for adding consecutive segments on one of the ends of the selected bar 

(indicate one of the ends of the bar, then indicate consecutive points of the broken line just 

like when inserting a customized bar). 

  – The function for removing the first or the last segment of the selected bar (indicate the 

first or the last segment of the bar). 

  – The function for modifying any indicated segment of the bar (indicate any segment of the 

selected bar, then indicate the end of the segment which you want to modify or indicate the 

target length for the modified segment). During the modification of the indicated bar segment, 

all the other segments which are located behind its indicated end will undergo a parallel 

translation. 

A customized bar is always inserted into the active view, by default in the plane of the top or bottom 

reinforcement cover for the top and bottom reinforcement views respectively, or in the cross-section 

plane for a cross-section. The bars inserted into the model this way (in any indicated view or cross-

section) can be then removed, moved, copied, turned and mirrored with the tools available in CAD 

programs using coordinates and snapping points. Utilization of the appropriate tools for a customized 

bar, such as: inserting a bar, view switching and adding the consecutive bar segments, allows even for 

inserting bars of spatial shapes into the model. 

3.8. INSERTING REINFORCEMENT DETAILS 

Every bar inserted into the model can be “projected” in the reinforcement drawing in the form of a 

bar copy with details (dimensions) of its structure presented and a description included. Three 

functions for this are available in the software:  – Inserts rebar details,  – Insert details for all 

rebars and  – Insert details of a spacer bar. All of these functions are accessible from the main 

toolbar of the software. Additionally, the first one is available in the action bar for a single mesh bar or 

a concentration, a customized bar inserted into the slab and for punching reinforcement bars. After 

selecting the  – Inserts rebar details function and indicating the bar from the model to which it 

should apply, indicate the location of the “projected” bar in the drawing. The drawing of a “projected” 

bar is not an element of the model (it is invisible in the 3D View), it is not included in the reinforcing 

steel list and it is not assigned to any view or cross-section. The drawing of bar details, aside from its 

shape, includes: automatically assigned number of the bar, its diameter, total length, length of 
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individual segments, dimensioned bend radiuses and arc length. The manner in which these 

parameters are presented depends on the settings selected in the software Options window. In the 

Element Properties: Rebar details window, you can set the font size for bar details descriptions. 

 

Rys. 35 The rebar details Properties window 

The  – Insert details for all rebars function works similar to inserting details for a single rebar but 

this time there is no need to indicate the bars for which the details should be inserted and the software 

itself finds all the bars of different shapes in the drawing and inserts “projected” bars for all the shapes 

at once. Several identical bar details may be inserted into a drawing as “projected bars” and their 

number does not affect the number of bars in the model or in the steel list. Every modification of an 

actual single bar in the model or changing all bars of a given type in the model at once (changing their 

dimensions, shape, diameter, etc.) automatically modifies the corresponding “projected” bar 

accordingly. If not all but only one or only some of the bars of a given type from the model are modified, 

the quantity of bars for the corresponding “projected” bar will change but the new type of “projected” 

bar will not be automatically included in the drawing. Therefore, every change of bar dimensions, 

shape or diameter should be completed by removing the current “projected” bars and inserting all the 

bar details again or adding the details of the modified bar to the previously inserted details of the 

“projected” bars. 

The last distinguished element is inserting spacer bar details. The function has been singled out in the 

software due to spacer bars not having their own graphical presentation in the views and cross-

sections of the model (they cannot be indicated in the drawing), only their quantity is calculated in the 

reinforcing steel list on the basis of user’s assumptions. 
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Rys. 36 Example drawings of “projected” bar details 

After selecting a drawing with bar details, base points become available, which enable to change the 

location of a “projected” bar and separately of its descriptions and dimensions in relation to it. 

3.9. INSERTING DESCRIPTIONS OF REINFORCEMENT INTO THE VIEWS AND CROSS-SECTIONS 

It is possible to insert reinforcement descriptions for rebars in the model into particular views and 

cross-sections. For this purpose, there is a special function in the software, located on the main toolbar 

 – Insert rebar descriptions. After selecting it, in the active view or cross-section, indicate the bars 

(the same or different) for which the description should be inserted. Next, indicate the view or cross-

section where you want to insert the description. It may be a different view then the one where the 

bars were indicated. The inserted description reference applies to all selected bars and if several 

different bars have been selected, the reference takes the form of a list, where each bar of a different 

number and shape is described in a separate line. The last operation for inserting descriptions is 

indicating the inserted description location in the drawing. Bar descriptions are not elements of the 

model but, as opposed to inserted bar details, they belong to the particular view and are removed and 

hidden together with it. When inserting the bar descriptions into a drawing, you can enter their 

Properties window from the action bar. 

 

Rys. 37 Action bar during insertion of bar descriptions 
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Rys. 38 Properties window for Bars description 

In this window, apart from setting the font size, you can define the appearance of a given description. 

To do this, press the Description appearance button which evokes an additional window for the 

description appearance configuration.  

 

Rys. 39 Description appearance configuration window 

In this window, you can discard the reference lines for a given description by unchecking Description 

on link. You can also determine which elements will be included in the description by selecting and 

moving the appropriate components from the left panel to the right and the other way around. The 

following elements are at your disposal here: Label (with bar number), Quantity and Diameter, 

Diameter, Spacing and Length. In the software, the following are defined for longitudinal bars by 

default: Label (with bar number), Quantity and Diameter, Diameter. If the description of mesh bars 

or concentration bars is modified to the following composition: Label (with bar number), Diameter, 

Spacing, the values of spacing from the mesh or the concentration Properties are adopted for the 

spacing parameter. The option of inserting bar descriptions can also be evoked from the action bar for 

selected mesh bars, punching reinforcement bars or customized bars. 
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Rys. 40 Example of bar description view for a slab reinforcement view 

3.10. INSERTING AGGREGATED REINFORCEMENT DESCRIPTIONS INTO VIEWS AND CROSS-
SECTIONS 

In beveled slabs, the quantity of different types of top and bottom reinforcement bars grows 

significantly, because each of the bars reaching the bevel has a different length. The quantity of bar 

numbers grows as well, because by default every bar which has different length gets an individual 

number in a project. To prevent extensive increase of descriptions in reinforcement views and 

reinforcing steel lists, the ability to make an aggregated numeration of bars has been included in the 

software. This ability always applies only to a bar group of any quantity, which have the same shape 

and properties (diameter, steel) and only one of their sections differs in length from the other bars, 

while the increase of this length is constant for all consecutive bars in the group. If at least one of the 

bars from the selected group does not meet the above specified requirements, the aggregated 

description for this group will not be created. A properly created aggregated description assigns one 

main number for the whole group of bars with constant length increase, and as many subnumbers as 

there are bars in the group. An example of such description may look like this: No. 9.1-7 7#16, what 

means that bar number 9 has 7 length variations and all 7 bars have a diameter of 16 mm. More details 

about aggregated bars can be found in the “projected” bar description, where aside from a designation 

similar to the one presented above, there are the change of the increasing section length (in this case 

from 2140 mm to 3217 mm every 179 mm) and medium length of the main number bar Lmed = 

3085 mm. Introduction of aggregated numeration for appropriate bars increases legibility of a drawing, 

reduces the quantity of necessary descriptions and bar details in a project and significantly reduces the 

size of reinforcing steel list (one item on the list corresponds to several bars of different length). If one 
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of aggregated bars has its shape, diameter or length changed, aggregation will be automatically broken 

and the software will return to consecutive numeration of bars. 

 

 

Rys. 41 Descriptions and details of aggregated bars 

Aggregation of bar numbers begins with evoking the function  – Insert a description of aggregated 

bars. After evoking it, the software awaits for the user to indicate all bars of constant length increase 

which should be aggregated to one main bar number (all indicated bars must meet the requirements 

specified above). Finish indicating the appropriate bars by pressing ESC or clicking the right mouse 

button. Next, in the action bar for aggregated descriptions, you can set their Properties similarly to 

standard descriptions and finish by indicating the location for aggregated description in the drawing. 

After you create aggregated descriptions, you can select them and break them into standard 

consecutive numeration by pressing the appropriate button at any time. 
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3.11. INSERTING A REINFORCING STEEL LIST 

In the software, inserting a reinforcing steel can be done in two different ways, using the functions 

from the main toolbar. Using the  – Insert a steel list for a structural element function, you can 

insert a list for the currently active structural element multiplied by the quantity of those elements 

inserted in slab Properties by the user. 

 

Rys. 42 Example of reinforcing steel list for a selected element (slab) 

The second function for inserting a reinforcing steel list into a drawing is  – Insert list of project steel. 

After selecting it and indicating the location in the drawing, the inserted list will include a total sum of 

all structural elements inserted in the drawing multiplied by the appropriate numbers defined by the 

user in the Properties of particular structural elements. 
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Rys. 43 Example of reinforcing steel list for entire project and all structural elements inserted 
in it 

3.12. INSERTING A SLAB GEOMETRY DIMENSIONING 

In order to insert slab geometry dimensions into a drawing, it is best to use dimensioning available in 

ArCADia. Then, the inserted dimensions will belong to appropriate views and cross-sections of a slab 

and will be able to be removed, hidden and moved together with them. Dimensions inserted into a 

drawing are not elements of a slab model but they belong to its appropriate views and cross-sections. 

Inserting dimensions always happens in currently active view through the  – Insert customized 

dimension function which is located in the main toolbar. After evoking the function, you can choose 

whether to insert a dimension: vertically and horizontally (default option) or parallel to points 

indicated in the drawing. 
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Rys. 44 Insertion bar for geometrical dimensions 

Next, indicate consecutive dimensioning points on the dimensioned construction. When you finish 

indicating the points, press the right mouse button and indicate the location of the dimension in the 

drawing. Then, a linear serial dimension of the indicated points will appear in the indicated location. If 

points which do not lie in one line are chosen for parallel dimensioning, the parallel serial dimension 

will be put parallel to the line indicated by the first and the last of the dimensioned points.  

Entering the Properties of the inserted dimension from the insertion bar or the action bar, you can 

define dimensioning style and font size for dimensions. 
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Rys. 45 Properties window for dimensioning 

The dimensioning unit for linear dimensions may be centimeter or millimeter, depending on the user 

defined global settings in the software Options window. Inserted dimensions may be moved (using 

handles visible after selecting a dimension) and removed. 

3.13. EXAMPLE OF DRAWINGS OF A SLAB CREATED IN ARCADIA–
REINFORCED CONCRETE SLAB SOFTWARE 
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Rys. 46 Examples of a slab drawing and 3D model view created using ArCADia–REINFORCED 
CONCRETE SLAB software 

 


